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 Architecture of  Small Body Mapping Tool 
(SBMT) 

 Tutorial guiding you through how to start 
up and use the SMBT including a discussion 
of 
 General features of the tool 
 Case study of the NEAR landing site 



 The SBMT consists of 2 parts: 
 SBMT Client 
 SBMT Server 



 The SBMT client is a program that runs on the desktop and 
communicates with the server to download data and perform 
queries. 

 Written in the Java (version 8) programming language for cross 
platform support 

 Uses additional 3rd party libraries: 
 VTK (http://vtk.org) for 3D visualization 
 Apache Commons Math for some mathematical procedures 
 JFreeChart for plotting 

 Additional Components 
 Bob Gaskell’s Mapmaker tool (in Fortran; about to converted to 

Bigmaps) 
 Implementation (in C++) of  algorithms for computing the gravity of 

a general polyhedron (either Werner and Scheeres or Cheng et al). 

http://vtk.org


 Supported on: 
 Mac OS X (10.5 or later) 
 Windows (Window 7) 
 Linux (most recent distributions) 

  The tool works best with 
 lots of memory 
 lots of bandwidth 
 good graphics card 



 The server consists of 2 components 
 A web server with PHP support 
 A MySQL database for storing metadata of images, 

spectra. 
 Judicious file structure for lidar datasets. 

 SBMT client can be configured to point to a 
server at different location 

 Searched data is cached on users local machine 
and only downloaded again if updated on the 
server 

 Currently over 2 TB of data on server 
 Much of data is publically available on PDS 



 Gaskell Shape Models 
 Bennu: Nolan, 2 truth models (4 not yet ready). Mapcam, Polycam images 

for all phases of the DRM Rev C for shape model 3; OLA data 
 Eros: MSI, NIS, and NLR, Gaskell maplets 
 Itokawa: AMICA, and LIDAR 
 Vesta: FC 
 Ceres (for Dawn team only): FC 
 Bennu: Gaskell maplets 
 Phoebe 
 Mimas 
 Phobos 
 Pluto, Charon, Nix, Hydra 

 Thomas shape models 
 Stooke shape models 
 Hudson (radar) shape models 
 Details of origin are listed in the help section of SBMT 



 Open  
 http://sbmt.jhuapl.edu/internal/ 

 Outside APL, enter your username and password in 
password.txt file (similar to license file) in same directory 
where you keep your SMBT application or  put it in the hidden 
./neartool 
 Mac and linux users: ~/.neartool 
 PC users: C:\Users\<username>\.neartool 

 You will need Java 8 or higher installed on your computer  
 Read the Download and Installation page for system 

requirements and detailed installation information. 

Click on 
appropriate file 

 

http://sbmt.jhuapl.edu/internal/


 The tool is divided 
into 2 main parts: A 
renderer panel on 
the right and 
control panel on 
the left. The 
renderer panel 
displays data in 3D 
and the control 
panel is used to 
control what gets 
displayed in the 
renderer. 
 

 In addition, there is 
a menu bar on top 
with additional 
options and a 
status bar on the 
bottom 
 
 

Renderer panel 

Control panel 

Status bar 



In the renderer view, 
rotate the asteroid by  
dragging the mouse 
while holding down the 
left mouse button. 



There are 2 ways to 
zoom in and out of the 
renderer. 
 
1. Use the mouse 

wheel 
2. Drag the mouse in 

the upward 
direction while 
holding down the 
right mouse button 
to zoom in. Drag the  
mouse in the 
downward 
direction while 
holding down the 
right  mouse down 
to zoom out. 



Panning moves the 
shape model sideways 
without rotating it.  
 
To pan, drag the mouse 
while holding down the 
middle mouse button 
or hold shift button and 
drag 



Spinning rotates the 
shape model around an 
axis that  points into 
the center of renderer 
view.  
 
To spin, drag the mouse 
while holding down the 
left mouse button and 
the control key. 



By default when 
rotating the camera 
(while dragging with 
left mouse button), the 
shape model rotates 
around the center of 
the shape model. 
 
To rotate around a 
different point on the 
shape model, position 
the mouse over that 
point and press the ‘c’ 
key. 
 
To return to the default 
center of rotation, 
press the ‘r’ key (for 
reset). 



Click on the “Export to 
Image…” in the File 
menu. Choose a format 
and name for the 
image. 



By default the vertical 
field of view of the 
camera is 30 degrees 
and the distance is 
chosen so the entire 
shape model fits  in the 
renderer view. 
 
To change these values, 
open the Camera… 
dialog in the File menu. 
 
Enter a field of view of 
5 degrees. 
 
Enter a distance of 
2000 km. 
 
Then click OK 



In the View menu, click 
on the Asteroids -> 
Near-Earth-> Bennu-> 
Image Based -> Gaskell 
(V3 Image) option.  



Click “Show Coordinate 
Grid” 

Click here 



Find some ancillary data. Go to: 
http://osiris-
rex.jhuapl.edu/altwg/outputdata/bennu_altwg/truth_products/bennuv3
/TRUTHBennuV3-products.html 
 
 

Click here 



 
 
Click “Customize Plate 
coloring” 
 
Navigate to ancillary 
data by clicking browse 
 
 

Click here 



 
 
Click “Customize Plate 
coloring” 
 
Navigate to ancillary 
data by clicking browse 
 
Name the data 
whatever you want, 
and add units if desired 
 
Click close 
 
You have now added an 
new layer in Plate 
Coloring ->Standard 

Click here 



 
 
Click  on Plate coloring 
standard toggle.  
 
Choose the new layer 
you added: Gmag 



 
 
Right click on image 
 
Choose Change Opacity 



 
 
Right click on image 
 
Choose Change Opacity 



Right click on any part 
of the coordinate grid. 
A context menu will 
appear on the renderer 
where you clicked. 
 
Click on the Change 
Color… option and 
select a new color. 

Context 
Menu 



Switch to the POLYCAM 
tab. This tab is used for 
searching and displaying 
POLYCAM images. 
 
Click the Search region 
to perform a search 
using the default search 
options. 
 
Click on select region, 
draw a search region, 
edit resolution and then 
click search to find 
images  
 
A list of images will be 
returned sorted by date. 
 
Boundaries of images 
will appear if images are 
smaller than object.  

Polycam Image Search 



By default the 
boundaries of the first 
10 matched images are 
shown in red in the 
renderer. If none or 
seen, it is because most 
images exceed size of 
observed object. You 
can see more 
boundaries by 
changing the boundary 
number or clicking the 
forward arrow. To map 
the image to the shape 
model, right click on 
the image and click 
“Map Image” 
 
You can right click 
either on an item in the 
list or a boundary in 
the renderer view 

Map Image in Returned List 

Mapped Image 



You can center the 
image in the renderer 
view which reorients 
the shape model to 
mimic how the 
spacecraft viewed the 
shape model when it 
acquired the  image. 
 
Right click on an image 
and click “Center in 
Window” 

Center Image in Renderer 
View 



You can center the 
image in the renderer 
view which reorients 
the shape model to 
mimic how the 
spacecraft viewed the 
shape model when it 
acquired the  image. 
 
Right click on an image 
and click “Center in 
Window” 

View asteroid as seen by 
camera 



You can look at the 
original POLYCAM 
image and stretch it 
for visualization on 
the shape model by 
right clicking on the 
image highlighted in 
the list or the image 
boundary. 
 
You can stretch the 
image, or physically 
move it if it doesn’t 
align properly. You 
can save 
adjustments you 
have made. 
 

Check out properties of image 
and stretch 



Map more than one 
image and play with 
stretch to get images 
to match up. 
 
Currently can simply 
export result as a 
png which via 
fie>export to image. 
 
As some point will 
be able to export a 
mosaic as a fits or 
Envi file. 
 
 
 

Quick mosaic 



To obtain the original 
image left click on image 
and then click on save 
original fits file  
 
Also useful to download 
info file if you plan to 
manipulate file and want 
to bring what you 
created back into SBMT. 
 
To obtain a “backplane” 
image with incidence, 
emission, phase, lat, 
long, radius, x, y, z, 
elevation, slope and so 
(from shape model 
currently selected) and 
left click on image in 
render or in list. 
 
Image is output as a 
DDR.IMG file with PDS 3 
label 
 
 
 

Downloading the original 
image or a backplane 



To obtain a 
“backplane” image 
with incidence, 
emission, phase, lat, 
long, radius, x, y, z, 
elevation, slope and 
so (from shape 
model currently 
selected) and left 
click on image in 
render or in list. 
 
Image is output as a 
DDR.IMG file with 
PDS 3 label 
 
 
 

Downloading a back plane to 
an image 



Navigate to OLA  -> 
TreeSearch Tab 
 
Click on select 
region. 
 
Choose a feature 
where you want OLA 
data. Then click 
search.  
 
A little slow – but 
will provide all the 
data  
 
 

Find OLA data 



To identify a single 
OLA shot of interest 
 
Disable LODs 
 
Then click on point 
of interest 
 
Status shows when 
data was collected 
 
Highlights track of 
interest.  
 

Find Individual OLA data 



Check the “Color Eros 
by” checkbox. You will 
now see the asteroid 
colored by slope. 

Click here 



The slope base map 
ranges from close to 
zero to about 45 
degrees. We will now 
change the range from 
0 to 20 degrees. Click 
the “Rescale Data 
Range” button. In the 
new window, Enter 0 
for the minimum and 
20 for the maximum. 
Then click OK. 



If base maps are 
available, these can be 
shown by clicking the 
show map feature. 
 
Simple cylindrical 
projected maps can also 
be injested via the 
Images tab or by 
assigning values to the 
shape model plates 
 



Switch to Structures tab 
and within that tab click 
on the Paths tab. 
 
Press New to begin 
drawing a Path. 
 
You will be in Edit mode 
in which the shape 
model is frozen in the 
renderer and you will 
not be able to rotate, 
zoom and pan. 
 
In the renderer view 
click on the shape model 
to specify the vertices of 
the Path. 
 
When finished drawing 
the Path, press the Edit 
button to return to 
normal navigation mode. 

Draw Paths on Shape Model 



Switch to Structures tab 
and within that tab click 
on the Polygons tab. 
 
Press New to begin 
drawing a polygon. 
 
You will not be in Edit 
mode in which the shape 
model is frozen in the 
renderer and you will 
not be able to rotate, 
zoom and pan. 
 
In the renderer view 
click on the shape model 
to specify the vertices of 
the polygon. 
 
When finished drawing 
the polygon, press the 
Edit button to return to 
normal navigation mode. 

Draw Polygons on Shape Model 



To determine the area 
in the polygon, right 
click on polygon in 
control panel, and click 
on display interior. 
 
If you want to save the 
information on the 
facets in the polygon 
(including the ancillary 
data you have added) 
use save plate data.  

Draw Polygons on Shape Model 



 
If you want to save the 
information on the 
facets in the polygon 
(including the ancillary 
data you have added) 
use save plate data.  

Draw Polygons on Shape Model 



Switch to Structures tab 
and within that tab click 
on the Circles tab. 
 
Press Edit to begin 
drawing circles. 
 
In the renderer view 
click on the shape model 
3 times on the perimeter 
of the circle. After 
clicking the third point, a 
circle will appear 
through the 3 points. 
 
Click  on another 3 
locations to draw a 
second circle. 
 
When finished drawing 
circles, press the Edit 
button again to return to 
normal navigation mode. 

Draw Circles on Shape Model 



Click on the Edit button 
to enable Edit mode. 
 
Position the cursor 
over a circle. The 
cursor will change  to a 
hand shape. 
 
Drag the circle while 
holding down the left 
mouse button to move 
it to a new location 
 
Drag the circle while 
holding down both the 
left mouse button and 
the control or shift 
button to change its 
size. 

Change position and Size of 
Circle  



Switch to Structures 
tab and within that tab 
click on the Ellipses 
tab. 
 
Press Edit to begin 
drawing ellipses. 
 
Click on the shape 
model 3 times, first 
along the semi-major 
axis, and then 
perpendicular along 
semi-minor axis. After 
clicking the third point, 
an ellipse will appear 
through the 3 points. 
 
When finished drawing 
ellipses, press the Edit 
button again to return 
to normal navigation 
mode. 

Draw Ellipses on Shape Model 

22.0m 



Click on the Edit button to 
enable Edit mode. 
 
Position the cursor over an 
ellipse. The cursor will 
change  to a hand shape. 
 
To change the flattening of 
the ellipse (ratio of semi-
minor to semi-major axis), 
drag the ellipse while 
holding down the left mouse 
button and the ‘z’ or ‘/’ 
(forward slash) key. 
 
To change the orientation of 
the ellipse, drag the ellipse 
while holding down the left 
mouse button and the ‘x’ or 
‘.’ (period) key. 
 
The position and size of an 
ellipse can be changed in 
the same manner as circles. 
 
 

Change Flattening and 
Orientation of Ellipse  



Switch to Structures 
tab and within that tab 
click on the Points tab. 
 
Press Edit to begin 
drawing points. 
 
Each time you click on 
the shape model with 
the left mouse button, a 
point will appear at 
that location. 
 
When finished drawing 
points, press the Edit 
button again to return 
to normal navigation 
mode. 

Draw Points on Shape Model 



Two main ways to import 
a shape model into sbmt 
 
Quick and dirty approach 
– you just made an obj 
and you want to take a 
look. 
 
At command line run: 
Runsbmt nameoffile.obj  
 
If you want to add 
ancillary data, images 
and so on. 
 
View>import shape 
model 
 

Importing a regional DTM  



Click on New 
 
Type in name of new 
shape model. 
 
Choose new model type: 
You have the option of 
generating an ellipsoid 
or adding a new shape 
model (OBJ, PLT – 
Gaskell plate format, or 
Vtk fomat)  
 
Custom model: browse to 
model 
 
 
 

Importing a regional DTM  



Click on View 
 
Select from list of model 
you imported 
 
Chose OLA DTM 
 
 
 
 

View Imported DTM  



Click on Images 
 
Click on New 
 
Click on Browse 
and find image 
you would like to 
place over model 
 
You may need to 
rotate and flip 
image depending 
on camera (not 
required for these 
Polycam images) 
 
 
 
 

Overlay an Imported Image on 
Imported DTM  

Can overlay image  using simple cylindrical projection or sbmt 
infofile or gaskell sumfile. Infofiles can be generated once an image is 
saved from SBMT. They are also easy to compute. 
  



Left click on 
image that you 
imported 
 
Click Map image 
 
 
 
 

View Imported Image on 
Imported DTM  



Switch to Structures 
tab and within that tab 
click on the Path tab. 
 
Press Edit to begin 
drawing path. For 
profile use only two 
points. 
 
Press Edit to get out of 
edit mode. Then right 
click on the path you 
just created and save 
profile. It will output all 
available data 
associated with shape 
model along path. 
 

Drawing a profile across the 
asteroid 



 
 
 
 
Import profile in your 
favorite plotting 
program (gnuplot 
output shown) 

Drawing a profile across the 
asteroid 

Difference between 
a truth DTM and a 
simulated OLA DTM  



Want a white background? Change the color of the axes shown or remove it 
altogether? 
Changing lighting of model? 

Changing preferences 



Want a white background? Change the color of the axes shown or remove it 
altogether? 
Changing lighting of model? 

Changing preferences 



Want a white background? Change the color of the axes shown or remove it 
altogether? 
Changing lighting of model? 

Changing preferences 

Changed  
Lighting model 

Add/Remove 
color axes 



Want a white background? Change the color of the axes shown or remove it 
altogether? 
Changing lighting of model? 

Changing preferences 

Change background color 
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